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Attachment A

These Release Notes contain descriptions of changes in POS Release 14.3 scheduled for October 18, 
2010. These have been distributed via HRA email.  If you would like to be added to the distribution list, 
please contact Sandra Hilton.  Prior Release Notes may also be found on the HRA Intranet at 
http://hrawebapps/HRAintranet/CMT_page_template.cfm?page_id=79
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1. Advantage Program Changes 
 
The Advantage Program is coordinated between HRA and the Department of Homeless Services 
(DHS) to provide eligible shelter residents with rental assistance in securing and establishing 
permanent housing. The new Advantage Program began on August 1, 2010, and is open to: 
 
 households with children residing in a DHS-funded or DHS-operated shelter/hotel for a minimum of 

60 days or an HRA-operated domestic violence shelter for a minimum of 42 days, or New York City 
Children’s Services (ACS) youth in group settings aging out of foster care; 

 adult households (couples) without minor children residing in a shelter for a minimum of 60 days; 
and  

 single adults residing in shelters for a minimum of 60 days. 
 
New Housing Advantage Indicator (HAI) Codes 
When a household enters the Advantage Program, the Food Stamp (FS) actual shelter expense will be 
the family’s contribution amount and will remain the same for the first year of the lease agreement. In 
addition, because the Advantage Program rental supplement may exceed the maximum CA shelter 
allowance, the household will not receive a CA shelter allowance in their needs calculation. To prevent 
staff from entering a CA shelter allowance and to identify the different Advantage programs, the 
following new HAI Codes have been developed: 
 
 W – Work Advantage 1st year 
 F – Fixed Income Advantage 1st year 
 9 – New Housing Advantage 1st Year (used by ODVEIS) 

 
These new codes will be added to the POS rent expense and budget windows.  
 
Previous HAI Codes: 
The previous HAI codes will remain on cases still under year one of the old Advantage Program. 
 
FS shelter allowance must equal $50: 
 
 1 (Work Advantage [Shelter is $50 or less]) 
 5 (HRA Work Advantage [Shelter is $50 or less]) 

 
FS shelter allowance must equal $0: 
 
 2 (Fixed Income Advantage [Shelter is $0]) 
 3 (Children Advantage [Shelter is $0]) 
 4 (HRA Advantage [Shelter is $0]) 
 6 (HRA Fixed Income Advantage [Shelter is $0]) 
 7 (HRA Children Advantage [Shelter is $0]) 

 
Program Confirmation 
POS receives a file with clients enrolled in the Advantage programs. In the CA Application Interview, 
POS will confirm whether the applicant is in the Advantage Program using the lease start date, the 
lease end date and the client’s issuance history. 
 
Rent Expense window edits 
In the rent expense window in the CA Application Interview, POS will display the following message 
when the system finds that the applicant is enrolled in a new Advantage program: 
 
“This case was found to be an Advantage Rental Assistance Housing Program case where the rent is 
pre-paid to the landlord. The shelter type code for this case must be ‘01’. A contribution amount of 30% 
or 40% of the income must be entered in the FS Actual shelter amount and the PA shelter amount must 
be ‘0’ and there must be a proration indicator of ‘O’ (Letter). 
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POS will display the following message when the system finds that the applicant is enrolled in an old 
Advantage program: 
 
“This case was found to be an Advantage Rental Assistance Housing Program case where the rent is 
pre-paid to the landlord. The shelter type code for this case must be ‘01’. If the Housing Advantage 
Indicator is listed as anything other than ‘Work Advantage’, the PA shelter amount must be zero, and a 
proration indicator of ‘O’ must be entered. If the Housing Advantage Indicator is listed as ‘Work 
Advantage’, the PA shelter amount cannot be more than $50” 
 
Special HAI Permission for Housing Program Cases 
Housing Program Center (center 018) staff will be able to change the value of the Housing Advantage 
Indicator (HAI) for active cases, when necessary. This field will be read-only for all other centers. 
 

 
 
CA Opening Code A30 under status SI 
CA opening code will be available to Housing Program Center (018) East River Center (037) staff under 
CA status of Single Issue (SI) for the processing of Advantage Program cases. 
 
Policy Directive 
For budgeting and case processing instructions, and additional information, please see PD 10-31-ELI 
Advantage Rental Assistance Program. 
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2. Changes to M-384 OCSE Appointment Notice 
 
The M-384 (OCSE Appointment Notice) was updated to add an applicant signature. In order to allow 
capture of the electronic signature, the printing of the form will be moved from the OCSE Referral 
window to the Print Forms window when the OCSE Referral Recommendation is Make a Referral and 
the applicant will be scheduled for an in-office OCSE appointment via NYCWAY Action Code 940A 
(OCSE Referral). 
 
OCSE Referral Appointment window 
 

 
 
Printing the revised M-384 Form 
After booking the OCSE appointment, the Worker must access the Print Forms window, select the M-
384 OCSE Appointment Notice and click on the Print button. The M-384 form will be printed and the 
eForm Signature window will appear.  
 
The Worker must retrieve the form from the printer and allow the applicant to review the information on 
the printed form. Once the information is confirmed and the applicant is ready to sign, the Worker must 
place the signature space of the M-384 on the electronic signature pad. The Worker must then click on 
the Sign button.  
 
The signature capture window will appear. The applicant must sign the form using the electronic and ink 
pen. The Worker must then verify that the signature was successfully captured and click Accept to 
save the signature. 
 
The Worker will then click on the Next button. POS will save the M-384 (OCSE Appointment Notice) to 
the HRA One Viewer, along with the captured signature. 
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Print Forms 
 

 
 
E-Form Signature window 
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Signature Capture window 
 

 
 

3. POS Portal Citywide Implementation 
 

The web-based POS Portal provides a centralized point of access to the Food Stamp Paperless Office 
System and several other applications regularly used by FIA Center staff. The user will have one 
central location to assist them in accessing, reviewing and processing cases.   
 
The POS Portal will allow access to the Food Stamp Paperless Office System, POS Management 
Console and the POS release notes. In addition; the portal will also provide access to the following 
Non-Cash Assistance Logs: Application Log, Recertification Log, Deferral Log and the NCA FS 
calendars.  The web-based Front Door Reception (FRED) application will also be included in the portal.  
 
The POS Portal also provides access to other applications outside of the Paperless Office System. The 
following links are available to the user from the POS Portal Home Page: 
 
 HRA Home Page 
 HRA One Viewer 
 FIA Telephone Recertification Reporting System (IVRS) 
 Food Stamp Employment Tracking System (FSE) 
 Automated Child Care Information System (ACCIS)  
 Public Transportation Automated Reimbursement System (PTAR). 
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POS Portal Home Page Window  
 

 
 
Removal of POS Primary and POS Secondary Icons 
The POS Primary and POS Secondary icons will be removed from the desktop. Staff must access POS 
through the POS Portal icon. To view the POS Sign-On Site, staff must click on the POS (Paperless 
Office System) link on the POS Portal. 
 
Appendix 
For additional information, please see Appendix B: POS Portal. 
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4. Single Issuance for FS Separate Determination Cases 
 
The FS Single Issuance windows and transactions will be upgraded to allow direct transmission of 
grants from POS to WMS for FS Separate Determination cases at Job Centers. The upgrade will also 
centralize printing of back-up grant authorization forms and help eliminate errors in data entry. 
 
Grant Summary window 
The Grant Summary window integrates business rules to help ensure accuracy and reduce grant 
issuance errors and duplication. 
 
The Worker can view the current case number, the re-use case number (if any), the current center, 
grant issuance history and any grants in progress. 
 
To enter a new grant, the Worker will click on the New Grant button. To edit a grant in progress, the 
Worker will select the grant and click on the Grant Details button. 
 
Grant Summary window 
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Grant Issuance History 
To view the grant issuance history, the Worker will click on the Grant Issuance History button. They 
may view up to 12 months of past grants. 
 

 
 
Benefit Data Entry Window 
The benefit data entry window will allow entry of multiple grants at a time. Initially, one grant space will 
be available. Once the Worker enters information for the first grant, a second row will appear. After 
entering the grants, the Worker will click ‘Done’. Business rules will verify the entered grants against 
WMS benefit issuance history and display error messages, if appropriate. 
 
After the business rules pass, the Worker will return to the Grant Summary window. 
 
Deleting a grant 
The Worker can delete a grant that was mistakenly entered by: 
 
 selecting the grant in the Grant Summary window; 
 clicking on the Grant Details; and  
 clicking on the Delete Grant button. 
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Single Issue Benefit Data Entry Window – no grants entered 
 

 
 
Single Issue Benefit Data Entry Window – one grant entered 
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Submission to Supervisor 
Once the activity is ready for submission to the supervisor, the Worker will access the Approval 
Elements window or will select the Close menu.  
 
Approval Elements window 
 

 
 
The Approval Assignment window will appear and indicate whether there are ready grants for the 
activity. The Worker will submit the case to the supervisor for approval. 
 
Approval Assignment Window 
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Supervisory Review 
 
After the Worker completes their activity, the Supervisor must review the activity, including the Grant 
Summary window, and approve or disapprove the processed grants: 
 
 The Grant Summary window will track the status of the approval/disapproval. 
 The supervisor can view benefit issuance history and the detailed entries made by the Worker. 
 If the supervisor disapproves the grant, a comment will be required. 

 
Grant Summary window in approval activity 
 

 
 
Benefit approval window 
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Grant Form Printing and Transmission 
Upon completion of the activity, the grants will be transmitted to WMS, with the exception of back-up 
grants with FS grant code 16, which will be submitted to the Single Issue Printing Queue. 
 
Grants Returned to the Worker 
If the activity is returned to the Worker, the Disapproved Elements window will display grants that were 
disapproved by the Supervisor. 

 
Disapproved Elements window 
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5. TALX Information Window Enhancement 
 

The TALX Information window will be updated to automate entries when no TALX match is found. 
When the Worker clicks No for “TALX Match Found”, the system will automatically set the following 
fields: 
 
 the Ready to TALX Record Outcome field will be set to “Ready”; 
 the TALX Outcome field will be set to “TALX was unable to find a Social Security Number match”; 
 the Hit field will be set to “No”; and 
 the Resolution field will be set to “Nothing to Resolve.” 

 
TALX Information Window 
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6. Document Re-Use Expansion 
 
In many instances, case documents required for eligibility are already available in the HRA One Viewer.  
The Document Reuse process facilitates the reuse of existing documents for eligibility factors that do 
not require new documentation for each application or recertification, thus reducing the need for 
workers to duplicate scanning and indexing of existing documentation. 
 
Whenever a document is required in POS for identity, citizenship or relationship, POS searches the 
One Viewer to determine whether the document was previously scanned. Effective October 18, 2010 
POS will also look for documentation for resources, absent parent information and alien status for non-
citizen case members. 
 
Example: Documents Found window 
 

 
 
This window lists all documents found in the image repository related to the individual(s) and eligibility 
factors for which documents can be reused. Workers have the ability to view the documents and to use 
them as necessary. This window appears prior to the Individual detail window in the POS interviews. 
 

7. New Edit for Homebound Question in POS 
 

A new edit will be added to the Medical window to prevent Workers from removing the homebound 
indicator for an individual in POS. If the Worker attempts to change the answer for the question “Is any 
Adult in the Household Homebound” from ‘Yes’ to ‘No’ and there is at least one individual with a 
homebound indicator, the system will prevent the change from happening and will display the following 
error message: “The homebound indicator can only be removed by designated FIA staff.” 
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8. Homebound Data Retrieval in Schedule CA Recertification Appointment 
 

The Calendar window in the Schedule CA Recertification Appointment currently retrieves data from 
POS and NYCWAY to determine whether a participant should be scheduled for a home visit 
appointment. Additional edits in the window will ensure the retrieval of the homebound indicators from 
POS and NYCWAY each time the window opens, if the Worker suspends the activity and returns to it at 
a later time.  
 
Reminder: Home Visit Settings in the Calendar window 
When the Calendar window opens, POS will make an OpenTI call to retrieve action codes from 
NYCWAY to determine whether the client qualifies for a travel accommodation or flexible appointment 
hours. The following action codes will be retrieved:  
 
 16TE (WeCARE Temporary Employment Call-In Exemption) 
 16TT (WeCARE Para-Transit Services Needed) 
 16TH (WeCARE Flexible Appointment Hours) 

 
If NYCWAY action code 16TE or 16TT is found for the casehead, the case will be scheduled for a home 
visit. If NYCWAY action code 16TH is found, NYCWAY will provide day and time ranges for which the 
client is not available for the recertification appointment. 
 
For  Cash Assistance cases that are not in center 052 (RTSC) and do not have action codes 16TE or 
16TT, POS will determine whether the casehead is homebound using POS and NYCWAY data.  
 
If the casehead is homebound, the question “Does this case require a home visit for face-to-face 
(FFR)?” will be prefilled with an answer of “Yes”. The Worker must then select the date and time of the 
appointment. The appointment must be at least 10 days in the future. 
 
If the casehead is not homebound, the Worker must indicate whether s/he is an R.E.D. (Returning 
Eligibility Determination [BEV]) Worker and whether the case requires a home visit for FFR. 
 
If the case requires a home visit for FFR, the Worker must indicate whether an FFR home visit 
appointment was arranged by phone and the date of the phone conversation, if applicable. The Worker 
must then select the date and time of the appointment. The appointment must be at least 10 days in the 
future. 
 

9. Expansion of High-Performance Review Pilot to Dyckman and Fordham 
 

The High-Performance Review (HPR) pilot will be expanded from the Linden Job Center to the 
Dyckman and Fordham Job Centers. This implementation includes the following functionality: 
 
 Full supervisory review of a percentage of selected cases and for cases under HPR exceptions  
 Disapproval reason selection menu in the supervisory approval windows; 
 Direct transmission from POS to WMS for non-selected cases; 
 Implementation of the Notice Selection window; 
 Implementation of the Notice Printing Queue for centralized printing of client notices at the HPR Job 

Centers; 
 Printing and mailing of six client notices by MIS (EBT-23, LDSS-3152, LDSS-4013, LDSS-4753 and 

M-3mm); and 
 Implementation of the Worker-Only Activity and AJOS 2 Review reports in the Management 

Console. 
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10. Reminders: High Performance Review (HPR) Pilot 
 
Selection of DSS-3574 and DSS-3575 forms in Notice Selection Window 
The HPR pilot has implemented the Notice Selection window.  
 
In this window: 
 
 The DSS-3575 form will only be selected when there are CA grants that will not be transmitted to 

WMS (Pick-Up Code 4, 5 or 7) or that are back-up grants. 
 The DSS-3574 form will only be selected when the FS grants are marked as back-up grants. 

 
These forms will not be selected when all grants will be transmitted directly to WMS by the final level of 
approval. 
 
Required WMS TTSS bits for Transmission of Grants 
New staff members in a center with the HPR pilot require the following WMS TTSS Bits to transmit 
grants to WMS: 
 
 0158 – Expedited Food Stamps (EFS) 
 0178 – Food Stamp Single Issue (FS SI) 
 0229 – Public Assistance Single Issue (PA SI) 

 
Requests for these security bits must be submitted to the Office of Data Security Management (OSDM) 
via the Auto Paperless Access Request Transmission (APART) system. 
 

11. Automated Medicaid Separate Determination (MSD) 
 
If an applicant/participant is denied or becomes ineligible for Cash Assistance (CA), for a reason that 
does not apply to the eligibility requirements for Medical Assistance (MA), a separate Medicaid 
determination is required. An applicant may choose to apply for CA and Food Stamps (FS) and not 
apply for MA. In such cases, if the CA application is denied, a separate determination for MA is not 
required. 
 
A new process will be created to automate processing for cases where Medicaid Separate 
Determination (MSD) is required. For cases requiring MSD, POS will submit MA-relevant data and 
documents entered on the CA case to the Eligibility Data and Image Transfer System (EDITS) for 
processing of the MA decision or deferral for required MA documentation. 
 
Determination for MSD Required, MSD Not Required and Manual MSD Review Required 
POS will receive nightly files from the NYC MAPPER system of individuals with eligibility decisions 
processed five business days earlier. These files will indicate whether the case was reopened since the 
initial decision and whether the individual was found in an open status (AP, AC, SI or IC) on a Cash 
Assistance or Medicaid case.  
 
The cases found with an open status will be marked as not requiring MSD. For cases with a closed CA 
status, POS will verify whether the closing was a single issue closing. If the closing was not a single 
issue closing, the case will be marked as not requiring MSD because the closing code will determine if 
MA is continued. 
 
If the CA eligibility transaction was completed outside of POS, the case will be marked as requiring 
manual MSD review. 
 
POS will submit MA relevant data and documents to EDITS for processing of the MA decision or a 
deferral for required MA documentation. 
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POS will update the case activity history for the CA case with the outcome of this system review for 
MSD. 
 
Policy Directive 
For additional information on the existing MSD policy and process, please see PD 10-23-ELI Separate 
Medicaid Determinations. 
 

12. Posting of NYCWAY Action Code 11DU (No Longer a Childcare Provider) 
 

When the applicant/participant answer is Yes for the question “Does the Applicant/Participant claim 
they stop providing childcare?” in the ACCIS Clearances window, POS will post action code 11DU (No 
longer a childcare provider) to NYCWAY. The code will be posted when the Worker clicks the Next 
button in the window. 
 
Appendix 
For additional information, please see Appendix B: ACCIS Clearances. 
 

13. New Approved Amount Edit for Single Issue Grant Requests 
 
A new business rule will compare the total grant amount entered for a grant request in the data entry 
window (SI Task 7) against the approved amount entered in the Referral and Outcomes section in SI 
Task 6. If the amounts differ, the following warning message will appear: “Approved amount in SI Task 
6 does not match entered grants”. 
 

14. New Interview Data Edits for Single Issue Grants 
 
New business rules will warn the Worker that an expense was not recorded in POS interview when they 
attempt to record certain grant types.  
 
When the Worker enters CA grant codes 10 (Utility grant to prevent turn off/restore services [prior to 
PA]), 41 (Utility grant to prevent turn off or restore utility services [mismanagement]) or 50 (Non-
recoupable utility grant [no mismanagement]) in the Data Entry window, but did not record a gas/electric 
expense and did not enter a heating bill expense, the following message will appear: “Gas/electric 
expense was not recorded and heating bill expense was not recorded in the interview.” 
 
When the Worker enters CA grant codes 09 (Rent only), 30 (Rent payments in excess of maximum), 31 
(Pre-PA rent arrears), 39 (Rent in advance to secure apartment), 40 (Rent in advance to prevent 
eviction), 43 (Accrued rent while on PA), 59 (NYCHA rent arrears), 75 (Rent held in escrow) or 77 
(Court ordered retroactive payment), but did not record the rent expense, the following message will 
appear: “Rent expense was not recorded in the interview.” 
 
When the Worker enters CA grant code 05 (Pregnancy allowance), but did not record the pregnancy 
and expected date of confinement (EDC) in the interview, the following message will appear: 
“Pregnancy was not recorded in the interview.” 
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15. Single Issue Reminders: Removing Grants Associated with a Grant Request  
 
Occasionally, the Worker may mistakenly mark a grant request as accepted and begin the data entry of 
single issue grants.  
 
To correct the decision and remove grants associated with a grant request that is not ready to receive 
grants, the worker must access SI Task 6 and mark the request as Not Ready in the Grants tab.  
 
If the request will be denied or will be accepted without issuing a grant, the Worker must access SI 
Task 6 and: 
 
 Select a decision of Deny and enter the denial reason; or 
 Select a decision of Accept, select Other Action and enter the action taken on the case.  

 
When these steps are completed, the grants will be deleted from the system. 
 

16. Pre-filling Center in Case Transfer with Covering Center for Zip Code 
 

In the CA Case Transfer activity, POS will prefill the New Center menu with the center covering the 
participant’s residential zip code. The Worker can change the prefilled value if the case will be 
transferred to a different center. 
 

17. Sorting by Date and Time in CA Login Queue 
 

Workers and Supervisors will be able to sort the Login Queue by the Date and Time columns. 
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18. WMS 2010.3 Change: New BVI Indicator 
 
New BVI (Birth Verification Indicator) field on WMS Inquiry Screens NQIN2A and NQCP03 
A new indicator named BVI (Birth Verification Indicator) has been added to the WMS inquiry screens 
NQIN2A (Client Information) and NQCP03 (Pending Individual Data). This field will be used for 
citizenship verification on Medicaid cases.  
 
Update to POS TAD 
The BVI (Birth Verification Indicator) field will also appear on the POS TAD next to the DGC field. For 
noncitizens who become naturalized citizens and who are active for MA, the Worker can enter a value 
of 3 (Verified by a worker) if the current value in WMS is B (Verified but not consistent with SSA data), 
C (Verified but deceased), D (Verified but deceased and not consistent with SSA data) or null. If the 
Worker attempts to input any value other than 3, the following error message will appear: “The BVI 
value can be replaced by ‘3’ only” 
 
If the current value for the field in WMS is 1 (Verified), 2 (Verified through automated newborn process), 
4 (Verified via EDITS/POS) or 5 (Deemed Verified [System Generated]), the Worker will not be able to 
change the value for this field in POS. 
 

 
 
Policy Directive 
For additional information on the usage of this new indicator, please see the Policy Directive for the 
WMS 2010.3 version. 
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19. Default Mailing Address for Undomiciled Applicants and Participants 
 
An entry in the mailing address fields is required for undomiciled applicants and participants. If the 
applicant or participants does not provide a mailing address, the default General Post Office address for 
the borough is used for the case. At the request of the United States Postal Service, the street address 
for these default addresses will be changed to GENERAL DELIVERY. The word GENERAL will go in 
the Street No field and the word DELIVERY will go in the Street Name field. 
 

 
 

20. Fix for Flow for Failed to Keep Recertification Cases 
 
When the case is marked as “failed to keep” in the FTK FFR window in the CA Recertification 
Interview, the activity for the CA Recertification Interview and Approve CA Recertification should 
be limited to the following windows: 
 
 Household Screen 
 FTK FFR 
 TAD 
 Approval Elements 

 
When the Worker clicked on the “Previous” button on the TAD, POS mistakenly displayed the full 
window set for the activity, rather than the shortened flow. This issue will be fixed in the October 18 
release. 
 

21. E-Forms 
 
The following E-Forms will be updated: 
 
 M-384, OCSE Appointment Notice 
 LDSS-3152-NYC, Action Taken on Your Food Stamp Case (NYC) 
 W-34A, Referral/Information Form 
 W-519, Finger Imaging Notice 
 W-607A, Request for Identification Card/Temporary Medicaid Authorization/Update Existing CBIC 

 
22. Reminder: TAD transmissions Prevented for an Inactive case  

 
When the Supervisor clicks on the Xmit (Transmit) button in the Approval Elements window, POS will 
compare the current CA case status in WMS and the CA case status selected in POS. The TAD 
transmission will not be posted if both the WMS CA and POS CA case statuses are inactive.  
 
In these instances the following message will be displayed: 
 
 This case is inactive in both WMS and POS TADs. No TAD or Grant transmission needs to 

be posted. 
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23. Single Issue Reminders: Re-Printing Grant Forms 
 

Once the Print Grant Forms row is completed in the Single Issue Printing Queue, the form cannot be 
printed from this queue. 
 
To reprint SI grant forms that were printed using the Single Issue Printing Queue, the worker must 
access the Review Case activity, click the Next button in the Activities window, select Tools and click 
on Printed Forms. The Worker can select the form and click on the Preview button to review the 
form(s) prior to printing. The Re-Print button will allow the Worker to re-print the form(s). 
 
Activities window 
 

 
 
Tools > Printed Forms Menu 
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Printed Forms window 
 

 
 

24. Reminder: Appendices 
 
 Appendix A, POS Portal 
 Appendix B, ACCIS Matches Update with New NYCWAY code 11DU 
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Overview 
 
The web-based POS Portal provides a centralized point of access to the Paperless Office System and 
several other applications regularly used by FIA Center staff. The user will have one central location to 
assist them in accessing, reviewing and processing cases.   
 
The POS Portal will allow access to the Paperless Office System, POS Management Console and the 
POS release notes. In addition; the POS portal will also provide access to the following Non-Cash 
Assistance Logs: Application Log, Recertification Log, Deferral Log and to the NCA FS calendars.  The 
web-based Front Door Reception (FRED) application will also be included in the portal.  
 
The POS Portal also provides access to other applications outside of the Paperless Office System. The 
following links are available to the user from the POS Portal Home Page: 
 
 HRA Home Page 
 HRA One Viewer 
 FIA Telephone Recertification Reporting System (IVRS) 
 Food Stamp Employment Tracking System (FSE) 
 Automated Child Care Information System (ACCIS)  
 Public Transportation Automated Reimbursement System (PTAR). 

 
POS Portal Home Page Window  
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Definitions  
 
NCA Food Stamp Application Log 
 
The Application Interview Log allows Food Stamp (FS) Centers to assign and reschedule application 
interviews and allows the processing of failed to keep transactions by designated staff. 
 
 

 
 
NCA Food Stamp Recertification Log 
 
The Recertification Interview Log allows Food Stamp (FS) Centers to view their past, current and future 
Recertification Interview appointments, to assign and reschedule their Recertification Interviews. 
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NCA Food Stamp Deferral Log 
 
The Food Stamp Deferral Log will allow Food Stamp Centers to close NCA FS cases in Single Issue 
(SI) status that were deferred for documentation and failed to return with the requested documentation.  
 

 
 
 
NCA FS Calendar  
 
The NCA FS calendar gives FS Site Managers and Assistant Site Managers the ability to create and 
maintain application appointment slots for designated NCA and CBO staff. In addition, FS Site Managers 
and Assistant Site Managers will have the ability to create new calendars as needed.  
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The POS portal also provides external links to other HRA applications that assist the FIA managers and 
workers in maintaining, updating, processing and reviewing cases. 
 
HRA One Viewer 
 
Provides FIA staff with the ability to search and retrieve documents and document-related information.  
 

 
 
Front-Door Reception (FRED) 
 
Application assist the receptionist at Job Centers/NCA Sites in routing applying individuals and those in 
receipt of benefits to the correct location within the offices.  
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Interactive Voice Response System 

IVRS provides certain NCA FS households with the opportunity to recertify for benefits by use of an 
automated telephone response system. 

 
 
 
Food Stamp Employment system (FSE) 
 
This system facilitates the management, enrollment and tracking of FS participants who are potentially 
required to participate in work activities.  
 
 

 
 

Attachment B



POS Release Notes: Appendix A 
Desk Guide – Introduction to POS Portal 
Version 14.3 October 18, 2010 

  6

 
Paperless Office System 
 
The Paperless Office system assists FIA staff in developing, processing and maintaining the NCA and 
Cash Assistance caseloads in an electronic case record.  
 

 
 
Management Console 
 
The management console houses reports designed to assist management and supervisory staff in their 
operational process. 
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POS Release notes  
 
Links to all published release notes located on the HRA Intranet. 
 

 
 
 
Automated Child Care Information System (ACCIS) 
 
ACCIS provides an integrated child care payment system that contains information on all active 
participants.  
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Public Transportation Automated Reimbursement System (PTAR) 
 
Metro card ordering system for FIA centers. 
 
 

 
 
 
 
The POS Portal will provide direct links to all of the previous noted applications. The external applications 
outside of POS (HRA OneViewer, ACCIS, IVRS, etc.) will open in their own window allowing the worker 
the ability to access and navigate the application fully.  
 
All POS related applications will link back to the POS portal which would save time by providing access to 
all the featured applications.  This portal will be updated to include access to other applications as they 
become available in the future.  
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ACCIS Clearances Window 
 
POS will now identify applying or active individuals who are also identified as child care providers 
receiving payment via the Automated Child Care Information System (ACCIS). POS will launch an 
automated lookup to ACCIS using the applicant/participant social security number at the time of 
application and recertification.  
 
If matches are found, a new ACCIS Clearances window will appear in the CA Application Interview, EC 
– CA Application Interview, CA Recertification Interview and EC – CA Recertification Interview 
activities after the Worker clicks the Next button in the Absent/LRR window.  
 
If there are communication problems between POS and ACCIS, the following error message will appear: 
 
 “The communication between POS and ACCIS has failed. Please try again later using the tool bar 

option under clearances.” 
 
ACCIS Clearance Window 
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POS Information 
The top section of the window will include the applicant/participant demographics and address information 
in POS. 
 

 
 
ACCIS Information 
The middle section of the window will include the applicant/participant demographics and address 
information in ACCIS. 
 

 
 
ACCIS Gross Income Information 
The lower section of the window will provide the gross income pay information from ACCIS for the last 
five months (if any). 
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Client Match Dispute 
The Worker will need to indicate whether the applicant/participant is disputing the match.  
 

 
 
If an applicant is disputing the match, the following message will appear: “You must make a proper 
referral to the Bureau of Eligibility Verification (BEV)” in the “Referrals” window”.  
 
If a participant is disputing the match, the following message will appear: “You must make a proper 
referral to Bureau of Fraud Investigation (BFI). Select the link in the Help Menu and submit Form BFI-14.” 
 
If the applicant/participant is not disputing the match, the Worker will need to indicate whether s/he claims 
that s/he stopped providing child care.  
 

 
 
If s/he claims that s/he stopped providing child care, the following message will appear:  
 
“You must capture applicant/participant signature.  If the signature pad is not working, you must print the 
form, have the applicant/participant sign it, then scan and index into the OneViewer. You must also, go to 
ACCIS and terminate childcare payments.” 
 
The signature capture for form W-274U (Attestation of Employment as a Childcare Provider) will appear. 
The Worker must capture the applicant/participant signature using the electronic signature pad or must 
have the applicant/participant sign the manual form and scan and index it into the OneViewer. 
 
Resolution 
The Worker will need to indicate a resolution for the ACCIS match information.  
 

 
 
For applicants, the Worker will need to indicate whether an FIA-3A was initiated and completed. There 
are three options under this menu: 
 
 Yes 
 No 
 Pending 

 
If the answer is No, a comment window will open and the Worker should provide a detailed explanation 
on why the FIA-3A was not initiated and completed. 
For participants, the Worker will need to indicate whether the child care income was previously budgeted 
with the correct amount and whether a recoupment was initiated due to the child care income match. 
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Completion Edit 
If the Worker indicated a resolution of Pending and they attempt to complete the application or 
recertification activity, a completion edit will require answers in the resolution section. The ACCIS 
Clearances window will open and the following error message will appear: 
 
 For applicants: “You must answer the question “Was an FIA-3A initiated and completed” of the 

resolution section of this window” 
 For participants: “You must complete the participant’s questions” of the resolution section of this 

window” 
 

NYCWAY Action Codes 
When a match is found in ACCIS, POS will post the following action code to NYCWAY: 
 
 11DP (Active CC provider review Pool) 

 
When the Worker indicates that a recoupment was initiated due to the child care income match, POS will 
post the following action code to NYCWAY: 
 
 11DB (Active CC provider recoup initiated) 

 
When the applicant/participant answer for Yes for the question “Does the Applicant/Participant claim they 
stop providing childcare?” in the ACCIS Clearances window, POS will post the following action code to 
NYCWAY when the Worker clicks the Next button in the window: 
 
 11DU (No longer a childcare provider) 

 
Supervisory Approval 
The ACCIS Clearances window will be added in the following approval activities and will appear when 
ACCIS matches are found: 
 
 Approve CA Eligibility Decision 
 Approve CA Recertification 
 Approve EC – CA Application Interview 
 Approve EC – CA Recertification 

 
The Supervisor will need to approve or disapprove the Worker’s entries in this window. The Approval 
menu will be available under the Window > Approval menu option. 
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Supervisory ACCIS clearance window 
 
 

 
 
Approval menu 
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Tools Menu Access to ACCIS Employment Clearances 
In addition, a new option named ACCIS Employment Clearances will be added to the POS Toolbar 
menu under Tools > Clearances to allow the worker to do an ACCIS search at any other POS activity. 
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